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Abstract 

 
This document describes the training package developed for the Water Resource Management (WRM) 
component of the European Space Agency (ESA) initiative ‘Earth Observation for Sustainable 
Development (EO4SD)’ which aims at increasing the uptake of EO-based information in regular 
development operations at the national and international level.   
 
The EO4SD project on water resource management will provide Earth Observation demonstrations on 
a large-scale in Africa (Sahel, Africa Horn and Zambezi), Asia (Myanmar and Lao PDR) and Latin 
America (Bolivia and Peru), and within water related operations of major IFI’s including World Bank, 
Asian Development Bank, Inter-American Development Bank and the Global Environmental Facility. 
The CD efforts will utilize the capacity offered by the new family of missions called Sentinel, developed 
specifically for the operational needs of the Copernicus program and carry a range of technologies such 
as radar, multi-spectral imaging instruments for land, ocean and atmospheric monitoring. 
 
The satellite data and various derived products are freely available through a number of data portals like 
the ‘Copernicus Open Access Hub’ (https://scihub.copernicus.eu/dhus/#/home). Sentinel 3 Marine 
Products are available through the Copernicus Online Data Access (CODA) Portal 
(https://coda.eumetsat.int) or for certain marine products even through EUMETCast, a DVB based 
telecommunication data dissemination system or through the EUMETSAT Data Centre.  
 
In order to easily ingest the online and EUMETCast delivered satellite information a small open toolbox 
has been developed, the so called ‘Sentinel EO4SD Toolbox’, allowing the ingestion of the currently 
available satellite images from Sentinel 1, 2 and 3 land and marine products into free and open GIS/RS 
processing software like ILWIS and QGIS.  
 
The main reason for development of this specific toolbox is based on the fact that in many of the 
countries targeted by the EO4SD Capacity Development effort, the available band width is limited and 
download of the full scenes (given their large file size) might be problematic. The toolbox allows 
processing of pre-selected spectral channels downloaded only, e.g. only 3 selected spectral channels 
out of the 14 available Sentinel 2 MSI instrument scene image data set to create a color composite 
instead of the full scene download. This reduces the overall download requirement substantially.  
 
The toolbox is developed using Python scripts in conjunction with an ILWIS Objects Python extension 
and Version 1 supports the pre-processing of Sentinel 1, 2 and 3 OLCI and SLSTR images and the 
available Level 2 land and marine products. Once more Sentinel data becomes available (like from S5P 
- Tropomi) more import routines will be included in updates of the toolbox. 
 
The training package consist of an introduction of Copernicus and the Sentinels, provides the required 
sensor and image data details of the various Sentinels, discusses how to obtain the data from online 
portals, how to obtain the software tools used and how to install these. Later on a set of exercises is 
presented on the use of the Sentinel data, the pre-processing, visualization and basic analysis applying 
the tools provided. 
  
Ben Maathuis, Suhyb Salama and Gabriel Parodi  
  
Department of Water Resources 
Faculty ITC – University of Twente 
Enschede, The Netherlands 
February 2018 

 
 
 
Partners in EO4SD WRM Consortium 
 
 
 



ii 

 

LIST OF ACRONYMS AND ABBREVIATIONS 

Adelphi  Adelphi 
CS  Client States 
DHI (Gras) Danish Hydraulic Institute - Gras 
eLEAF  eLEAF Feed the World 
EO  Earth Observation 
FR  Full Resolution  
EO  Earth Observation 
ESA  European Space Agency 
EUMETSAT European Organisation for the Exploitation of Meteorological Satellites 
GeoVille GeoVille Information Systems and Data Processing GmbH 
GIS  Geographical Information Systems / Geographical Information Science 
GUI  Graphical User Interface 
HH  Horizontal transmit, Horizontal receive SAR polarization 
HR  High Resolution 
HV  Horizontal transmit, Vertical receive SAR polarization 
IFI  International Financial Institution 
IR  Infra-red 
ITC  Faculty ITC, University of Twente 
L0  Level 0 
L1  Level 1 
L2  Level 2 
L3   Level 3 
LRM  Low Resolution Mode 
LST  Land Surface Temperature 
LWIR  Low Wave Infra-red 
MR  Medium Resolution 
MWIR  Medium Wave Infra-red 
MWR  Microwave Radiometer 
NetCDF Network Common Data Form 
NRT   Near real Time 
OC  Ocean Colour  
OLCI  Ocean and Land Colour Instrument 
RR  Reduced Resolution 
S1  Sentinel 1 
S2  Sentinel 2 
S3  Sentinel 3 
SAR  Synthetic Aperture Radar 
Satelligence Satelligence - Earth observation for society and environment 
SLR  Single Look Complex 
SLSRT  Sea and Land Surface Temperature Radiometer 
SM  Strip Map 
SST   Sea Surface Temperature 
Starlab  StarLab Living Science 
UTC  Universal Time Code 
UTM  Universal Transverse Mercator 
VH  Vertical transmit, Horizontal receive SAR polarization 
VIS  Visible 
VNIR  Visible and Near Infra-red 
VV  Vertical transmit, Vertical receive SAR polarization 
WRM  Water Resources Management 
WST  Water Surface Temperature 
WV  Wave Mode 
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1. THE COPERNICUS PROGRAM AND THE SENTINELS 

1.1 INTRODUCTION 

The Sentinel Satellites are developed for the specific needs of the Copernicus programme. Copernicus, 
formerly Global Monitoring for Environment and Security, is the European programme to establish a 
European capacity for Earth observation designed to provide European policy makers and public 
authorities with accurate and timely information to better manage the environment, and to understand 
and mitigate the effects of climate change. Through satellite and in situ observations, the Copernicus 
services deliver near-real-time data on a global level which can also be used for local and regional 
needs, to help us better understand our planet and sustainably manage the environment. The 
Copernicus Services transform this wealth of satellite and in situ data into value-added information by 
processing and analysing the data acquired. Datasets stretching back for years and decades are made 
comparable and searchable, thus ensuring the monitoring of changes. Patterns are examined and used 
to create better forecasts, for example, of the ocean and the atmosphere. Maps are created from 
imagery, features and anomalies are identified and statistical information is extracted. 
 
The Sentinel missions carry a range of technologies, such as radar and multi-spectral imaging 
instruments for land, ocean and atmospheric monitoring: 
 

 Sentinel-1 is a polar-orbiting, all-weather, day-and-night radar imaging mission for land and 
ocean services. Sentinel-1A was launched on 3 April 2014 and Sentinel-1B on 25 April 2016. 
Both were taken into orbit on a Soyuz rocket from Europe's Spaceport in French Guiana. 

 Sentinel-2 is a polar-orbiting, multispectral high-resolution imaging mission for land monitoring 
to provide, for example, imagery of vegetation, soil and water cover, inland waterways and 
coastal areas. Sentinel-2 can also deliver information for emergency services. Sentinel-2A was 
launched on 23 June 2015 and Sentinel-2B followed on 7 March 2017.   

 Sentinel-3 is a multi-instrument mission to measure sea-surface topography, sea- and land-
surface temperature, ocean colour and land colour with high-end accuracy and reliability. The 
mission will support ocean forecasting systems, as well as environmental and climate 
monitoring. Sentinel-3A was launched on 16 February 2016.  

 Sentinel-5 Precursor – also known as Sentinel-5P – is the forerunner of Sentinel-5 to provide 
timely data on a multitude of trace gases and aerosols affecting air quality and climate. It has 
been developed to reduce data gaps between the Envisat satellite – in particular the Sciamachy 
instrument – and the launch of Sentinel-5. Sentinel-5P was taken into orbit on a Rockot launcher 
from the Plesetsk Cosmodrome in northern Russia on 13 October 2017.  

 Sentinel-4 is a payload devoted to atmospheric monitoring that will be embarked upon a 
Meteosat Third Generation-Sounder (MTG-S) satellite in geostationary orbit.  

 Sentinel-5 is a payload that will monitor the atmosphere from polar orbit aboard a MetOp Second 
Generation satellite.  

 Sentinel-6 carries a radar altimeter to measure global sea-surface height, primarily for 
operational oceanography and for climate studies.  

 

As part of Copernicus, ESA (https://sentinel.esa.int/) will be responsible for the operation of Sentinels 1, 
2 and 3 (land) and EUMETSAT (www.eumetsat.int) will be responsible for the operation of Sentinel-3 
(marine), 4 and 5.  

Specifically, for water resource management the EO4SD will seek to demonstrate the benefits and utility 
of EO services in response to stakeholder requirements for water resources monitoring and 
management at local to basin scales. 

Some of the key water related priority areas where EO-based geo-information is needed include: 

 River basin characterization and change monitoring (e.g. hydrological network mapping, long-
term climate change analysis); 

 Water supply and sanitation (e.g. monitoring of water quality, extent and level of lakes and rivers 
to support management for agricultural, industrial and urban water use); 
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 Hydrological management (e.g. modelling and forecasts of runoff, river discharge and 
groundwater abstraction); 

 Water productivity (e.g. mapping of biomass production, evapotranspiration and crop type); 
 Risk management of natural hydrological hazards (e.g. mapping and forecasting of flooding, 

drought, landslides); 
 Industrial activity assessment (e.g. monitoring of freshwater fisheries, aquaculture, hydropower 

and mining). 

The EO4SD portfolio represent the EO-based information services which can support key priority issues 
for water resource management and planning. 

1.2 OBJECTIVES OF THE TRAINING PACKAGE 

EO4SD-WRM project has a capacity building component that is subdivided into continental and regional 
trainings. The continental trainings target International Financial Institutes (IFI’s) and managers in the 
client states (CSs) and address the wider context of EO applications and services. Whereas the regional 
trainings aim at supporting the stakeholders in the CSs to use and streamline EO products for the 
management of water resources. 
 
The main objectives of the EO4SD Capacity Development for the regional trainings are: 

 For IFI: Awareness and understanding of EO – capacity data and products for WRM 
 For Managers or lead of organizations: Support integration of EO-data and products into daily 

working practices of organization to improve planning and policy making for WRM  
 For Technical staff: Derive EO-based information and products for WRM 

 
This training package mainly supports the technical staff in the utilization of EO based data. 

1.3 THE SENTINEL EO4SD TOOLBOX 

The toolbox developed currently supports the import and pre-processing of Sentinel 1 A/B Level 1C 
Ground Range Detected Geo-Referenced Products, Sentinel 2 A/B Level 1C Multi Spectral Imager 
spectral channels and True Colour Image, Sentinel 3 Level 1 Ocean and Land Imager (OLCI) and Sea 
and Land Surface Temperature Radiometer (SLSTR) spectral channels and Sentinel 3, Level 2 Land 
and Marine products, like Land Surface Temperature and Sea Surface Temperature. For level 2 Marine 
products also those provided through the Copernicus Online Data Access portal and EUMETCast (for 
OLCI and SLSTR) are supported. Data processed using SNAP can be translated as well. Figure 1A is 
providing the main menu through which the user can make the selection of the satellite product to be 
ingested. 

Figure 1A: the Sentinel EO4SD Toolbox Opening menu 
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Once the user has selected a certain option from the main menu a sub menu appears, showing the 
required information for the final import of the image or product and the visualization / post processing 
software to be used. In general 4 parameters need to be specified, which can be selected interactively. 
A progress bar provides an indication of the state of advancement of the import routine. A sample using 
the Sentinel 2 True Colour Composite (Level 1C) is given below and the resulting visualization using 
QGIS in combination with Open Street Map, in figure 1C. 
 

Figure 1B: the Sentinel EO4SD Toolbox sub menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1C: Sentinel Level 1C TCI and Open Street Map 
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2. WORKING WITH DATA FROM SENTINEL 

2.1 THE SENTINEL SUITE OF SATELLITES 

As already indicated before, at the moment of writing this document a number of Sentinel satellites have 
been launched and are operational, like Sentinel 1A and B, 2A and B, 3A and Sentinel 5P is currently 
in commissioning phase. These satellites, for Sentinel 1 and 2 already two identical satellites in different 
orbit configuration, have different sensors designed with a specific objective, but all provide global 
coverage.  
 

Figure 2: Sentinel satellite configuration, 09 January 2018 at 12:25 UTC 

 
 
Some further background on the satellites is provided below as this is required to work with the data 
collected by the instruments on board of these satellites. Details presented are retrieved from the 
‘Sentinel User Handbooks’, the full handbooks are also available in the EO4SD Toolbox, see the menu 
in figure 1. Additional information is provided at: https://earth.esa.int/web/sentinel/sentinel-technical-
guides.   

2.2 SENTINEL 1 

The Sentinel-1 mission includes C-band imaging operating in four exclusive imaging modes with 
different resolution (down to 5 m) and coverage (up to 400 km). It provides dual polarisation capability, 
very short revisit times and rapid product delivery. Sentinel-1 potentially operates in four exclusive 
acquisition modes: 
 

 Strip Map (SM), 80 km swath, 5 x 5 m spatial resolution  
 Interferometric Wide swath (IW), 250 km swath, 5 x 20 m spatial resolution  
 Extra Wide swath (EW), 400 km swath, 20 x 40 m spatial resolution 
 Wave (WV), 20 x 20 km, 5 x 5 m spatial resolution 

 
The Sentinel-1 C-band SAR instrument supports operation in single polarisation (HH or VV) and dual 
polarisation (HH+HV or VV+VH), implemented through one transmit chain (switchable to H or V) and 
two parallel receive chains for H and V polarisation. 
 
SM, IW and EW are available in single (HH or VV) or dual polarisation (HH+HV or VV+VH). WV is single 
polarisation only (HH or VV). The primary conflict-free modes are IW, with VV+VH polarisation over 
land, and WV, with VV polarisation, over open ocean. EW mode is primarily used for wide area coastal 
monitoring including ship traffic, oil spill and sea-ice monitoring. SM mode will only be used on request 
for extraordinary events such as emergency management. 
 
Having the Interferometric Wide swath mode as the one main operational mode satisfies most currently 
known service requirements, avoids conflicts and preserves revisit performance, simplifies mission 
planning, decreases operational costs and builds up a consistent long-term archive. 
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For each mode, it will be possible to produce products at SAR Level-0 (raw), Level-1 SLC (Single Look 
Complex), Level-1 GRD (Ground Range Detected) and Level-2 OCN (Ocean). Spatial resolutions 
depend on the acquisition mode and the level of processing, see also table 1. 
 

Figure 3: Sentinel-1 Product Modes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 1: Acquisition mode details 
Mode Incidence Angle Resolution Swath Width Polarization 

(H=horizontal, 
V=Vertical) 

Stripmap 20 – 45 5 x 5 m 80 km 
HH+HV, VH+VV, 

HH, VV 
Interferometric 

Wide swath 
29 – 46 5 x 20 m 250 km 

HH+HV, VH+VV, 
HH, VV 

Extra Wide 
Swath 

19 – 47 20 x 40 m 400 km 
HH+HV, VH+VV, 

HH, VV 

Wave 
22 – 35 
35 – 38 

5 x 5 m 20 x 20 km HH, VV 

 
Sentinel-1 is in a near-polar, sun-synchronous orbit with a 12 day repeat cycle and 175 orbits per cycle 
for a single satellite. Both Sentinel-1A and Sentinel-1B share the same orbit plane with a 180° orbital 
phasing difference. With both satellites operating, the repeat cycle is 6 days. 
 
Level-1 data are the generally available products intended for most data users. Level-1 products are 
produced as Single Look Complex (SLC) and Ground Range Detected (GRD). Level-1 Single Look 
Complex (SLC) products consist of focused SAR data geo-referenced using orbit and attitude data from 
the satellite and provided in zero-Doppler slant-range geometry. The products include a single look in 
each dimension using the full TX signal bandwidth and consist of complex samples preserving the phase 
information.  
 
Level-1 Ground Range Detected (GRD) products consist of focused SAR data that has been detected, 
multi-looked and projected to ground range using an Earth ellipsoid model. Phase information is lost. 
The resulting product has approximately square resolution pixels and square pixel spacing with reduced 
speckle at the cost of reduced geometric resolution. GRD products can be in one of three resolutions: 
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Full Resolution (FR), High Resolution (HR) or Medium Resolution (MR). The resolution is dependent 
upon the amount of multi-looking performed. Level-1 GRD products are available in MR and HR for IW 
and EW modes, MR for WV mode and MR, HR and FR for SM mode.  
 
Level-2 OCN products include components for Ocean Swell spectra (OSW) providing continuity with 
ERS and ASAR WV and two new components: Ocean Wind Fields (OWI) and Surface Radial Velocities 
(RVL). The OSW is a two-dimensional ocean surface swell spectrum and includes an estimate of the 
wind speed and direction per swell spectrum. The OSW is generated from Stripmap and Wave modes 
only. For Stripmap mode, there are multiple spectra derived from internally generated Level-1 SLC 
images. For Wave mode, there is one spectrum per vignette. The OWI is a ground range gridded 
estimate of the surface wind speed and direction at 10 m above the surface derived from internally 
generated Level-1 GRD images of SM, IW or EW modes. The RVL is a ground range gridded difference 
between the measured Level-2 Doppler grid and the Level-1 calculated geometrical Doppler. 
 
Sentinel-1 can collect several different images from the same series of pulses by using its antenna to 
receive specific polarisations simultaneously. The Sentinel-1 SAR is a dual polarisation radar. It can 
transmit a signal and receive in both horizontal (H) and vertical (V) polarisation. Dual polarisation SAR 
products containing complex value and inter-channel phase information allow for measurement of the 
polarisation properties of terrain in addition to the backscatter that can be measured from a single 
polarisation. Targets on the ground have distinctive polarisation signatures reflecting different 
polarisations with different intensities and converting one polarisation into another. For example, volume 
scatterers have different polarisation properties than surface scatterers. Polarimetric decompositions 
allow the separation of different scattering contributions and can be used to extract information about 
the scattering process, providing improved classification of point targets and distributed target areas. 
 
A SAR signal contains amplitude and phase information. Amplitude is the strength of the radar response 
and phase is the fraction of one complete sine wave cycle (a single SAR wavelength). The phase of the 
SAR image is determined primarily by the distance between the satellite antenna and the ground targets. 
Interferometric SAR (InSAR) exploits the phase difference between two complex radar SAR 
observations of the same area, taken from slightly different sensor positions, and extracts distance 
information about the Earth's terrain. By combining the phase of these two images after coregistration, 
an interferogram can be generated where phase is highly correlated to the terrain topography and 
deformation patterns can be mapped. If the phase shift related to topography is removed from the 
interferograms, the difference between the resulting products will show surface deformation patterns 
occurred between the two acquisition dates. 
 
The top-level Sentinel-1 product folder name is composed of upper-case alphanumeric characters 
separated by an underscore (_). 
 

Figure 4: Product naming conventions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sentinel data products are distributed using a Sentinel-specific variation of the Standard Archive Format 
for Europe (SAFE) format specification. The SAFE format has been designed to act as a common format 
for archiving and conveying data within ESA Earth Observation archiving facilities. The Sentinel-SAFE 
format wraps a folder containing image data in a binary data format and product metadata in XML. This 
flexibility allows the format to be scalable enough to represent all levels of Sentinel products. A Sentinel 
product refers to a directory folder that contains a collection of information. It includes:  
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 a 'manifest.safe' file which holds the general product information in XML;  
 subfolders for measurement datasets containing image data in various binary formats;  
 a preview folder containing 'quicklooks' in PNG format, Google Earth overlays in KML format 

and HTML preview files;  
 an annotation folder containing the product metadata in XML as well as calibration data;  
 a support folder containing the XML schemes describing the product XML. 
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2.3 SENTINEL 2 

The spatial resolution of the Multi Spectral Instrument (MSI) on Sentinel-2 is dependent on the particular 
spectral band. For the 10 metre resolution also a True Colour Image (TCI) is provided. 

Figure 5: S-2 10 m spatial resolution bands: B2 (490 nm), B3 (560 nm), 
 B4 (665 nm) and B8 (842 nm) 

 

Figure 6: S-2 20 m spatial resolution bands: B5 (705 nm), B6 (740 nm), B7 (783 nm),  
B8a (865 nm), B11 (1610 nm) and B12 (2190 nm) 

 

Figure 7: S-2 60 m spatial resolution bands: B1 (443 nm), B9 (940 nm)  
and B10 (1375 nm) 

 

With its 13 spectral bands, 290 km swath width and high revisit frequency, Sentinel-2's MSI instrument 
supports a wide range of land studies and programmes. Two identical Sentinel-2 satellites operate 
simultaneously, phased at 180° to each other, in a sun-synchronous orbit at a mean altitude of 786 km.  
 
The MSI works passively, by collecting sunlight reflected from the Earth. New data is acquired at the 
instrument as the satellite moves along its orbital path. The incoming light beam is split at a filter and 
focused onto two separate focal plane assemblies within the instrument; one for Visible and Near-Infra-
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Red (VNIR) bands and one for Short Wave Infra- Red (SWIR) bands. The spectral separation of each 
band into individual wavelengths is accomplished by stripe filters mounted on top of the detectors. 
 

Table 2: Sentinel-2 product types 
Name High-level Description Production and Distribution Data Volume 
Level-1B Top-of-atmosphere radiances 

in sensor geometry 
Systematic generation and 
online distribution 

27 MB 
(each 25*23 km2) 

Level-1C Top-of-atmosphere 
reflectances in cartographic 
geometry 

Systematic generation and 
online distribution 

500 MB 
(each 100*100 km2) 

Level-2A Bottom-of-atmosphere 
reflectances in cartographic 
geometry 

Generation on user side 600 MB 
(each 100*100 km2) 

 
The Level-1B product is the lowest product level made available to users. Each Level-1B product is 
composed of an ensemble of granules that are 25 km across track (AC) by 23 km along track (AL). All 
granules that intersect with a user area of interest (AOI) are delivered. Each granule is approximately 
27 MB in size. The Level-1B product provides radiometrically corrected imagery in Top-Of-Atmosphere 
(ToA) radiance values and in sensor geometry. Additionally, this product includes the refined 
geometrical model which is used to generate the Level-1C product. Level-1B pixel coordinates refer to 
the centre of each pixel. 
 
The Level-1C product is composed of 100 km2 tiles (ortho-images in UTM/WGS84 projection). The 
Level-1C product results from using a Digital Elevation Model (DEM) to project the image in cartographic 
coordinates. Per-pixel radiometric measurements are provided in Top of Atmosphere (ToA) reflectances 
with all parameters to transform them into radiances. Level-1C products are resampled with a constant 
Ground Sampling Distance (GSD) of 10, 20 and 60 m depending on the native resolution of the different 
spectral bands. 
 
In Level-1C products, pixel coordinates refer to the upper left corner of the pixel. Level-1C products 
additionally include Land/Water, Cloud Masks and ECMWF data (total column of ozone, total column of 
water vapour and mean sea level pressure). 
 
The Level-1C Tile consists of: 

 Level-1C_Tile_Metadata_File (Tile Metadata): XML main metadata file (DIMAP mandatory file) 
containing the requested level of information and referring all the product elements describing 
the tile; 

 IMG_DATA: folder containing image data files compressed using the JPEG2000 algorithm, one 
file per band; 

 QI_DATA: folder containing QLQC XML reports of quality checks, mask files and PVI files. 
 Inventory_Metadata.xml: inventory metadata file (mandatory); 
 manifest.safe: XML SAFE manifest file (Mandatory); 
 rep-info: folder containing the XSD schema provided inside a SAFE Level-0 granule 

 
Level-1 Tile Image Data Naming Convention used is as follows:  
 

 S2A_OPER_MSI_L1C_CGS3_20141104T134012_123_15SWC_N11.11 
 
Where: 

 S2A is the spacecraft 
 OPER is the routine operations 
 MSI is the instrument. 
 L1C is the product level 
 TL is the granule 
 CGS3 is the processing centre in which the product is generated. 

 
The Level-2A prototype product is an orthorectified product providing Bottom-of-Atmosphere (BOA) 
reflectances, and basic pixel classification (including classes for different types of cloud). In the Level-
2A, the granules (also called tiles) consist of 100kmx100km squared ortho-images in UTM/WGS84 
projection, with one tile per spectral band. 
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Examples of S2 L2A product main directories are: 

 S2A_OPER_PRD_USER2A_047_20140417094512_201404171094728_20140417102538 
 S2A_OPER_PRD_USER2A_048_20140417112512_201404171112728_20140417102538 

 
Where: 

 S2A is the spacecraft 
 OPER is the routine operations 
 PRD is the product category 
 USER denotes a User-generated product 
 2A is the processing level 

 
Sentinel-2 products are made available to users in Sentinel-SAFE format, including image data in 
JPEG2000 format, quality indicators (e.g. defective pixels mask), auxiliary data and metadata. Similarly 
to Level-1C, Level-2A products are organized in ortho-rectified tiles of 100 km x 100 km in UTM WGS84 
projections. The imagery of each band is put in a separate JPEG2000 file. The values are Bottom-Of-
Atmosphere (BOA) reflectances. L2A specific bands are also computed:  
 

 AOT: Aerosol Optical Thickness map (at 550nm) 
 CLD: Raster mask values range from 0 for high confidence clear sky to 100 for high confidence 

cloudy 
 SCL: Scene Classification. The meaning of the values is indicated in the Category Names of 

the band. 
 SNW: Raster mask values range from 0 for high confidence NO snow/ice to 100 for high 

confidence snow/ice 
 WVP: Scene-average Water Vapour map 

 
When opening the main metadata .xml file, the driver will typically expose 4 sub-datasets:  

 one for the 4 native 10m bands, and L2A specific bands (AOT and WVP) 
 one for the 6 native 20m bands, plus the 10m bands, except B8, resampled to 20m, and L2A 

specific bands (AOT, WVP, SCL, CLD and SNW),  
 one for the 3 native 60m bands, plus the 10m&20m bands, except B8, resampled to 60m, and 

L2A specific bands (AOT, WVP, SCL, CLD and SNW), 
 one for a preview of the R,G,B bands at a 320m resolution 

 
 
All tiles of same resolution and projection are mosaiced together. If a product spans over several UTM 
zones, they will be exposed as separate subdatasets. 
 
L2A_Scene_Classification_ID (SCL product) uses the following coding system: 

0 = sc_nodata 
1 = sc_saturated_defective 
2 = sc_dark_feature_shadow 
3 =  sc_cloud_shadow 
4 = sc_vegetation 
5 = sc_not_vegetated 
6 = sc_water 
7 = sc_unclassified 
8 = sc_cloud_medium_proba 
9 = sc_cloud_high_proba 
10 = sc_thin_cirrus 
11 = sc_snow_ice  
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2.4 SENTINEL 3 

The main objective of the Sentinel-3 mission is to measure sea surface topography, sea and land 
surface temperature, and ocean and land surface colour and the data is jointly provided by ESA and 
EUMETSAT to deliver operational land observation and ocean services respectively. The spacecraft 
carries four main instruments: 
 

 Ocean and Land Colour Instrument (OLCI) 
 Ocean and Land Colour Instrument (SLSTR) 
 Synthetic Aperture Radar Altimeter (SRAL) 
 Microwave Radiometer (MWR) 

 
The two in-orbit Sentinel-3 satellites enable a short revisit time of less than two days for OLCI and less 
than one day for SLSTR at the equator. The orbit reference altitude is 814.5 km. Sentinel-3B orbit is 
identical to Sentinel-3A orbit but flown 180° out of phase with Sentinel-3A. 
 
The SLSTR instrument is a conical scanning imaging radiometer employing the along track scanning 
dual view technique (near-nadir and backward views). The main characteristics of the SLSTR are: 
 

 swath width: dual view scan, 1420 km (nadir) / 750 km (backwards) 
 spatial sampling: 500 m (VIS, SWIR), 1 km (MWIR, TIR) 
 spectrum: nine bands [0.55-12] μm 

 
The OLCI push-broom instrument swath is 1270 km. The OLCI swath is not centred at nadir but is tilted 
12.6° westwards to mitigate the negative impact of sun-glint contamination. Fully overlapping with 
SLSTR instrument swath and simultaneous acquisitions facilitates the use of OLCI and SLSTR in 
synergy. The main characteristics of the OLCI are: 
 

 swath width: 1270 km 
 push-broom imaging spectrometer with five cameras, mitigation of sun-glint contamination by 

tilting cameras in westerly direction 
 spatial sampling: 300 m at Sub Satellite Point 
 spectrum: 21 bands [0.4-1.02] μm 

 
The altimeter instrument (SRAL) does not have a swath like Sentinel-3 OLCI and SLTSR instruments. 
Across track, it receives a single measurement of the range (no image) every time a pulse is emitted. 
The main characteristics of the SRAL (Sentinel-3 Ku/C Radar Altimeter) are: 
 

 radar measurement modes: Low Resolution Mode and SAR (also called High Resolution Mode) 
 tracking modes: closed and open-loop 
 pulse repetition frequency: 1.9 KHz (LRM), 17.8 KHz (SAR) 
 total range error: 3 cm  

 
Figure 8: Sentinel-3 ground track resolutions 
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The main characteristics of the MWR (MicroWave Radiometer) are: 
 

 dual frequency, 23.8 / 36.5 GHz 
 radiometric accuracy, 3 K absolute (0.6 K relative)  

 
Based on the Sentinel-3 observations a processing chains for generating ocean colour and land 
reflectance, land and sea temperature and ocean and land topography products has been established 
as shown in the figure below. 
 

Figure 9: Sentinel-3 products structure 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
OLCI Level-1 and 2 data products are available to the general public. The OLCI files are collected into 
a SAFE container. Level-1 and 2 products are provided as netCDF4 product files. There are different 
data products associated with these levels of processing of OLCI:  
 

 Level-1 includes Top-of-Atmosphere (TOA) radiometric measurements, radiometrically 
corrected, calibrated and spectrally characterised. It is quality controlled, ortho-geolocated 
(latitude and longitude coordinates, altitude) and annotated with satellite position and pointing, 
landmarks and preliminary pixel classification (e.g. land/water/cloud masks). Products are 
generated in FR (300 m) and in RR (1 km) for the whole globe with the same coverage. 

 Level-2 products consist of geophysical quantities derived from the processing of measurement 
data provided in the Level-1 product. Level-2 products specifically for marine and land 
application domains are generated separately by ESA (land) and EUMETSAT (ocean). Level-2 
atmospheric information relevant for both application domains, such as water vapour, is 
reported in both data streams.  

 
Level-2 Land products in Full Resolution (FR) or Reduced Resolution (RR) (OL_2_LFR and OL_2_LRR) 
are: 
 

 surface product as Global Vegetation Index (OGVI) and Terrestrial Chlorophyll Index (OTCI)  
 atmosphere by-products as Integrated Water Vapour (IWV) column (this product also contains 

information for water pixels and is identical to that included in OL_2_WRR and OL_2_WFR)  
 error estimates for all products 

 
Several associated variables are also provided in the annotations data files: 
 

 rectified reflectance for red and MIR channels (RC681 and RC865) 
 classification, quality and science flags (LQSF) 
 common data such as the ortho-geolocation of land pixels, solar and satellite angles, 

atmospheric and meteorological data, time stamp or instrument information. These variables 
are inherited from Level-1B products. 
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Table 3: OLCI Level-2 land and atmospheric geophysical product 

 
 
Level-2 Water / Ocean products in Full Resolution (FR) or Reduced Resolution (RR) (OL_2_LFR and 
OL_2_LRR) are: 
 

 water-leaving reflectance (Rxxx) for all bands except those dedicated to measurement of 
atmospheric gas. Two types of reflectance are distinguished: the BAC reflectance for "Baseline 
Atmospheric Correction algorithm"(MERIS heritage) or AAC reflectance for "Alternative 
Atmospheric Correction algorithm" (based on a neural network procedure). BAC is used for the 
operational output of the reflectance in this product package but in cases where reflectances 
are computed and AAC is needed, a setting has been defined in the configuration file to switch 
between algorithms. 

 ocean colour products such as algal pigment (chl_oc4me and chl_nn, in two separated files), 
Total Suspended Matter (TSM_NN) concentrations and transparency characterisation based 
on the Diffuse Attenuation coefficient (KD490_M07). 

 neural network water-inherent optical properties such as CDM absorption (ADG_443_NN). 
 atmosphere by-products such as Photosynthetically Active Radiation (PAR), Aerosol Optical 

Depth /Aerosol Angstrom exponent (gathered in one file and noted respectively as T865 and 
A865) and Integrated Water Vapour (IWV) column. Note that this last variable also contains 
information for water pixels and is identical to the one included in OL_2_WRR and OL_2_WFR.  

 error estimates for all the products. 
 
Several associated variables are also provided in the annotations data files: 
 

 classification, quality and science flags (WQSF) 
 common data such as the ortho-geolocation of land pixels, solar and satellite angles, 

atmospheric and meteorological data, time stamp or instrument information. These variables 
are inherited from Level-1B products. 

 
Table 4: OLCI Level-2 water / ocean and atmospheric geophysical product 
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SLSTR Level-1 and 2 data products are available to the general public. The SLSTR files are collected 
into a SAFE container. Level-1 and 2 products are provided as netCDF4 product files. There are different 
data products associated with these levels of processing of SLSTR:  
 

 Level-1 includes Top-of-Atmosphere (TOA) radiometric measurements, radiometrically 
corrected, calibrated and spectrally characterised. It is quality controlled, ortho-geolocated 
(latitude and longitude coordinates, altitude) and annotated with satellite position and pointing, 
landmarks and preliminary pixel classification (e.g. land/water/cloud masks). 

 Level-2 products consist of geophysical quantities derived from the processing of the 
measurements data provided in the Level-1 product. Level-2 products specifically for marine 
and land application domains are generated separately by ESA (land) and EUMETSAT (ocean). 

 
Based on the combination of SLSTR and OLCI products, SYN is composed of mainly two Level-2 
product types: 
 

 Surface reflectances and aerosol parameters over land projected on OLCI 300 grid for all 
SLSTR and OLCI channels (except thermal and absorption) 

 SPOT continuity products reproducing similar characteristics of the VEGETATION instrument 
observation. Ensuring the continuity of SPOT VEGETATION missions, its main aim is 
monitoring land use, its evolution and impact of weather and climate on agricultural activities. 
SYN is also an essential information source for worldwide food security. It would also be able 
to add to climate studies by supplying a continuous NDVI time series initiated by AVHRR and 
VEGETATION. 

 
The SYN Level-2 product is composed of five different packets, all available to the user except the VGK 
product: 
 

 SY_2_SYN includes surface reflectances and aerosol parameters over land 
 SY_2_VGP includes TOA reflectances on 1 km VEGETATION-like product 
 SY_2_VGK includes surface reflectances and NDVI for spectral VGT channels 
 SY_2_VG1 includes 1 day synthesis surface reflectance and NDVI on 1 km VEGETATION-like 

product 
 SY_2_V10 includes 10 day synthesis surface reflectance and NDVI on 1 km VEGETATION-like 

product. 
 
For further information consult the Sentinel-3 SYN User Guide, available at https://sentinels. 
copernicus.eu/web/sentinel/user-guides/sentinel-3-synergy. The official release of these products to the 
user community is planned during 2018. 
 
SRAL/MWR Level-2 products, corrected for geophysical effects (including the Level-1 data corrections 
for instrument effects) are available to the general public. SRAL/MWR files are collected into a SAFE 
container. Level-1 and 2 products are provided as netCDF4 product files. The main application of the 
Sentinel-3 topography mission is the study of ocean topography including mean sea level, wave height, 
wind speed over the surface, sea-ice, ocean currents, Kelvin and Rossby waves, eddies and tides. The 
geophysical parameters to be measured by the Sentinel-3 topography mission are: 
 

 Sea Surface Height (SSH) 
 Significant Wave Height (SWH) 
 Wind speed over ocean surface. 

 
The ESA Broadview Radar Altimetry Toolbox (BRAT) can be used to visualise and operate Level-2 
products, see also http://www.altimetry.info/toolbox/.   
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2.5 DATA DOWNLOAD FROM COPERNICUS OPEN ACCESS HUB 

The ‘Copernicus Open Access Hub’ is available at https://scihub.copernicus.eu/dhus/#/home, free 
registration can be done online. It is assumed that you have registered and have access to the Hub. 
 
The Open Access Hub currently provides complete, free and open access to Sentinel-1, Sentinel-2 and 
Sentinel-3 (Land) user products. The following products are currently available: 
 
For Sentinel-1the Level-0 and Level-1 user products for the following acquisition modes are available:  

 Strip Map (SM) 
 Interferometric Wide Swath (IW) 
 Extra Wide Swath (EW) 

 
Level-2 user products for the following acquisition modes:  

 Wave (WV) 
 
The Sentinel-2 data provided within the Open Access Hub is consisting of Level-1C and Level-2A user 
products. 
 
The Sentinel-3 data in the Open Access Hub consists of Level-1 and Level-2 (Land) user products for 
the OLCI, SLSTR and SRAL instruments. 
 
When navigating to the ‘Copernicus Open Access Hub’ a web-server is shown in your browser, identical 
to the figure below. Use the “Pan” option to change the geographic location and the “Box” option to 
select your AoI. 
 

Figure 10: the Copernicus Open Access Hub portal 

 
 
Different search criteria for the different products can be inserted, e.g. here as example the platform 
selected is Sentinel-1A (S1A_*) and the product type is GRD. The search area covers the Netherlands. 
 
When activating the “Search” icon a search is conducted applying the criteria used. Once the search is 
completed the results are shown, as indicated in the figure below. By scrolling through the search result 
list one can select the most suitable image(s). For most of the products, next to the small quick looks 
available to get an idea about the image details (e.g. in term of cloud cover – note that this is not 
applicable for Sentinel-1), other options for a selected product are to zoom to the product in the map 
window, to view product details, to add the product to the cart and to download the product. Also the 
direct download URL is provided. 
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Figure 11: View search results 

 
 
Using the option “view product details” another window opens, see also the figure below. 
 

Figure 12: View your selected product details 

 
 
Using the slide bars at the bottom and right hand side of this window allows one to see the complete 
information provided. It should be noted that additional information is provided when selecting, under 
“Inspector” the file details. This provides the option do download individual files and not the whole data 
set. It should be noted that the complete datasets are of considerable file sizes. If only a few channels 
are required, download of these specific channels only can be helpful especially when working in a low 
bandwidth environment. For some software tools the full data set is required, like when SNAP is going 
to be used. When using the EO4SD toolbox the individual images / channels can be processed. 
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2.6 DATA DOWNLOAD FROM COPERNICUS ONLINE DATA ASSESS SERVICE 

The Copernicus Marine Sentinel-3 data is processed at EUMETSAT and the Sentinel Level-1 and Level-
2 Marine data is available online through the CODA portal. Download service offers all the recently 
acquired Sentinel-3 marine and atmospheric products through a rolling archive that (at a maximum) will 
span 12 months. 
 
If you already have an Earth Observation Portal (EO Portal) account, use your account credentials to 
log into CODA. Go to https://coda.eumetsat.int (please use Chrome or Firefox). Click ‘OK’ to be 
redirected to the EO Portal login screen. Alternatively go to https://eoportal.eumetsat.int/ 
userMgmt/login.faces, create a new account, log in and follow the link 'Copernicus Online Data Access'. 
Older data (than 12 months including the Copernicus Sentinel-3 marine and atmospheric products) can 
also be ordered through the EUMETSAT Data Centre, for further information see: 
https://www.eumetsat.int/website/home/Data/DataDelivery/EUMETSATDataCentre/index.html.    
 
Once logged in the Java web based Data Hub is displayed, see also the figure below. The top right icon 
allows to draw your region of interest or to navigate on the map. The other features are identical to the 
Copernicus Open Access Hub, described above.  
 

Figure 13: the CODA – Marine Portal 

 
 
Note the following acronyms for OLCI and SLSTR Level-1 and Level-2 products: 
 

 OL_1_EFR or OL_1_ERR: Full (FR) or Reduced (RR) resolution top of atmosphere radiance 
 OL_2_WFR or OL_2_WRR: Full (FR) or Reduced (RR)  resolution water and atmosphere 

geophysical products 
 

 SL_1_RBT: Brightness temperature and radiances. 
 SL_2_WST: Level 2P Sea Surface Temperature (GHRSST like) 
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Figure 14: CODA results

 
 

For further information on CODA download, see also: https://coda.eumetsat.int/manual/CODA-user-
manual.pdf. Note that individual channels can be retrieved, no need to download the full products if 
there is a bandwidth limitation. 
 
Level-1 (EFR, ERR) and Level-2 OLCI (WRR) Marine products are currently also provided through 
EUMETCast. It is planned to add the Ocean and Land Colour Instrument (OLCI) Full Resolution (FR) 
Level L2 data to the EUMETCast satellite service in 2018, date has yet to be confirmed. In the meantime 
one can download these data via CODA or order them through the Data Centre. 
 



19 

 

3. DOWNLOAD AND INSTALLATION OF SENTINEL EO4SD TOOLBOX 

3.1 DOWNLOAD OF THE SOFTWARE 

A number of software tools are required to work with the data provided by the Sentinel program. The 
software tools used within this training package are all freely available and can be obtained online. 
Below the sources to download the software are described. All tools used are for a Windows 64 bit 
Operating System. Tools have been tested on Windows 7 and Windows 10. Not all tools are required 
to run the EO4SD toolbox. The use of the toolbox requires Python, two Python extensions (Gdal and 
netCDF4), ILWIS-Python plugin and ILWIS or QGIS, used for visualization of the Sentinel data imported. 
SNAP (and Snappy) can be used later on. 
 
Python 3.4 
Python, here version 3.4 is used (to ensure compatibility with “Snappy” for advanced use). For download 
go to https://www.python.org/ download/releases/3.4.3/, or go to the following download page: 
https://www.python.org/downloads/release/python-343/. Select from the table “Windows x86-64 MSI 
installer” for the 64 bit Python version. 
 
For use of Snappy under Python see also: https://senbox.atlassian.net/wiki/spaces/SNAP/ 
pages/50855941/Configure+Python+to+use+the+SNAP-Python+snappy+interface. 
 
To operate the EO4SD Toolbox a few python extensions are required, you can download these as 
Python Wheels (*.whl) from https://www.lfd.uci.edu/~gohlke/pythonlibs/. Download for your Python 
version installed the following wheel packages, or more recent versions (here for python 3.4, 64 bits): 

 GDAL, here ‘GDAL-2.2.3-cp34-cp34m-win64.whl’ 
 NetCDF4, here ‘netCDF4-1.3.1-cp34-cp34m-win64.whl’ 

 
ILWIS Version 3.8.5 
Go to https://github.com/52North/Ilwis3Downloads/releases/tag/v3.8.5 and download the file 
‘n52_ilwis_v3_08_05.zip’. A more recent version “ILWIS385z.zip” is available from 
ftp://ftp.itc.nl/pub/52n/EO4SD/.  
 
 
ILWIS Python extension Version beta3.0 
Download ILWISObjects-beta3.0-forPython3.x-64bit.exe that corresponds to your Python version from 
https://github.com/52North/IlwisCore/releases/tag/v1.0-beta3.0, also check http://ilwis.itc.utwente.nl/ 
wiki/index.php/Getting_started:_Download. Download and check the Installation guide as well. 
 
 
QGIS Version 2.14 - QGIS-Essen 
Go to: https://www.qgis.org/en/site/, select the option ‘download now’ and select from the Long Term 
Release repository the version “QGIS Stand Alone Installer 2.14 (32 or 64 bit, which will be used here)”. 
You can also go to http://download.qgis.org. 
 
SNAP Version 5 
Go to http://step.esa.int/main/toolboxes/snap/. Select the Sentinel toolbox for your operating system, 
e.g. Windows 32 or 64 bit. Use the ‘download’ link, note that 64-Bit is used here, to ensure compatibility 
with the other resources. Note that SNAP is using JAVA. Most likely Java is already available on your 
system, if this is not the case, then navigate to https://java.com/en/download/ and follow the installation 
instructions. 
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3.2 INSTALLATION INSTRUCTIONS 

Please follow installation sequence as described below if you want to start installation from scratch. 
Always start with the installation of Python. Quick installation instructions (using a copy of python34, 
including all the wheels) is described in the Appendices under quick installation instructions: ‘Quick 

install EO4SD‐Toolbox and ancillary tools’. 

To install from scratch: 
 
Install Python, here Version 3.4  
 
When selecting the ‘Windows x86-64 MSI installer’ (the 64 bit version) the ‘python-3.4.3.msi’ is 
downloaded. Activate the ‘msi’ to run the Python 3.4.3 Setup. Use the following, mostly default, setup 
options: 
 

 Install for all users 
 Use default directory (C:\Python34\) 
 Use the option in Customize Python 3.4.3: Add Python.exe to Path  and select the option: “will 

be installed on local hard drive” 
 Installation will start and press finish to exit Installer 
 Open a Python session and check if the installation is correct. 

 
Other ancillary plug-ins /software used under Python. 
 
Copy the wheel (*.whl) packages (the wheel packages used to develop the tool are also available at 
ftp://ftp.itc.nl/pub/52n/EO4SD/, see “wheel_resources.zip”) to you Python directory. Open the Command 
Prompt ‘CMD’ and navigate to the Python directory, here c:\python34. Type the following commands 
and check after installation / upgrade if the process has been successful: 
 

Python –m pip install - -upgrade pip 
Python –m pip install GDAL-2.2.3-cp34-cp64m-win32.whl 
Python –m pip install netCDF4-1.3.1-cp34-cp64m-win32.whl 

 
Eventually delete the 2 *.whl files after installation from the Python34 directory. 
 
Install the ILWIS Objects Python extension, here Version beta3.0 
 
Double click with your mouse the downloaded ‘ILWISObjects-beta3.0-forPython3.x-64bit.exe’ that 
corresponds to your Python version (here for Python 3.4). Follow the ILWIS Objects install wizard, you 
will be asked to select the Python 3.4 installation directory of the 64 bits Python installation to configure 
the extension. Note that this folder (usually C:\Python3x) is different than the folder where ILWIS Objects 
is installed (usually C:\Program Files (x86)\n52\ILWISObjects). 
 
EO4SD Toolbox, here Version 1 
 
Unzip the “EO4SD toolbox”, e.g. on the root of your C or D drive, here D drive is used. Navigate to the 
directory “EO4SD_py”, right click with the mouse on the file ‘EO4SD_start.py’, select the option from the 
context sensitive menu “edit with IDLE”, check the file content and press F5, the Python Shell and the 
EO4SD Toolbox will appear. 
 
Finally you have to install a RS – GIS package for visualization, raster calculation and image 
enhancement – manipulation. Here the option is the use of free resources like ILWIS or QGIS. 
  
Install ILWIS, here Version 3.8.5 
 
Unzip the file downloaded, run the setup and use the default installation options. Start an ILWIS session 
to check the installation. 
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Install QGIS, here Version 2.14 - QGIS-Essen 
 
Activate the installer, here “QGIS-OSGeo4W-2.14.21-1-Setup-x86_64” downloaded and: 
 

 Use default installation settings 
 Save eventual work and reboot your system 
 Start a QGIS session to check installation 

 
Not all functionality is available in the tools provided, if you look for some advanced tools then the 
Sentinel Application Platform (SNAP) should be used. Note that to make optimum use of SNAP a 
complete download of a selected Sentinel data sets is required. 
 
Install SNAP, here version 5. 
 
Run the installer ‘esa-snap_sentinel_windows_5_0.exe’ (install4y.wizard): 
 

 Use default installation settings 
 Activate the option: Configure SNAP for Python, navigate to the Python34 directory and select 

python.exe 
 Installation starts, accept the other defaults and press finish to complete installation 
 Start SNAP to check if installation is correct 

 
Most likely, once a new session of SNAP is started, a message appears that new updates are available. 
Accept the message and the updates will be installed and SNAP will be restarted to allow the updates 
to be activated. 
 
 
With all these tools installed you are ready to conduct the exercises as provided in the next chapters. 
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4. WORKING WITH THE SENTINEL EO4SD TOOLBOX  

4.1 APPLY THE TOOLBOX TO IMPORT SENTINEL DATA AND PRODUCTS FOR USE IN ILWIS/QGIS 

In the table below a summary is provided on the Sentinel data in Full Resolution (FR) which can be 
processed using the toolbox. The table is providing the naming convention of the SAFE file ‘container’. 
 

Table 5: Toolbox Sentinel data processing routines 
 

Satellite Instrument Level Channels / 
Polarizations 

Products File name prefix 

S1 A / B SAR L1C-
GRD 

Single and 
dual 
polarizations 

IW mode S1A_IW_GRDH_1SDV_ 

S2 A / B MSI L1C 01-21 ToA radiance S2A_MSIL1C_ * 
MSI L1C  TCI S2A_MSIL1C_ * 

S2 A / B MSI L2 01-21 BoA 
reflectance 

S2B_MSIL2A_* 

MSI L2  TCI L2A_T31UFU_ * _TCI_* 
S3 A - Land OLCI L1 01-21 ToA radiance S3A_OL_1_EFR_ * _SVL* 

SLSTR L1 VIS – SWIR: 
01-06 

ToA radiance S3A_SL_1_RBT_ * _SVL* 

  TIR: 07 - 09 ToA BT S3A_SL_1_RBT_ * _SVL* 
  F: 01 - 02 ToA BT S3A_SL_1_RBT_ * _SVL* 
OLCI L2 ogvi OGVI S3A_OL_2_LFR_ * _LN1* 
  otci OTCI S3A_OL_2_LFR_ * _LN1* 
SLSTR L2  LST S3A_SL_2_LST_ * _SVL* 

S3 A - 
Ocean 

OLCI L1 01 - 21 ToA radiance S3A_OL_1_EFR_ * 
_MAR* 

OLCI L2 01-12, 16-18, 
21 

BoA 
reflectance 

S3A_OL_2_WFR_ * 
_MAR* 

  chl_oc4me Chl-open 
water 

S3A_OL_2_WFR_ * 
_MAR* 

  trsp KD490-open 
water 

S3A_OL_2_WFR_ * 
_MAR* 

  chl_nn Chl-complex 
water 

S3A_OL_2_WFR_ * 
_MAR* 

  Iop_nn ADG443- 
complex water 

S3A_OL_2_WFR_ * 
_MAR* 

  Tsm_nn TSM-complex 
water 

S3A_OL_2_WFR_ * 
_MAR* 

SLSTR L2  SST-skin S3A_SL_2_WST_ * 
_MAR* 

Other Import from SNAP-DIMAP format *.dim 
  
 
Within the SAFE file all required data is available. If there is no problem downloading the data then the 
whole ‘SAFE’ file can be downloaded onto the local hard disk and the file can be decompressed before 
use within the toolbox.  
 
On the other hand when download capacity is limited due to small internet band width, individual files 
required for processing can be selected based on the User needs, see details in figure 12 and figure 
14. The table below is showing per Sensor / level and product the type of files required to operate the 
toolbox. In all cases for Sentinel 1 and 2 the selection of the bands / or polarizations is sufficient. For 
Sentinel 3 additional files are required as the geocoding is stored as a separate netCDF4 layer. For the 
S3-OLCI-Land-LST product also the “flags” are required to allow further post-processing, e.g. to remove 
the impact of clouds. 
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Table 6: Individual data layers to be downloaded to operate the toolbox routines 
 

 Satellite 
/ Sensor 

Resolu-
tion / 
Level 

Product bands Name input file Input geolocation 
file / other ancillary 

data 
S1 IW / L1C GRD  All polari- 

zations 
S1a-iw-grd-**.tiff none 

S2 L1C MSI 
bands 

01-12 T31UFU_**_Bxx.jp2 none 

  TCI 1 T31UFU_**_TCI.jp2 none 
 L2 (at 10, 

20 and 60 
m) 

MSI 
bands 

01-12 L2A_T31UFU_**_Bxx_
10m.jp2 

none 

  TCI, AOT, 
SCL, VIS, 
WVP 

1 L2A_T31UFU_**_TCI_
10m.jp2 
(as example for TCI) 

none 

S3 - Land 
OLCI FR / L1 Radiance 01-21 Oa_xx_radiance.nc Geo_coordinates.nc 
SLSTR FR / L1 Radiance 

(VIS-
SWIR) 

1-6 Sx_radiance.nc Geodetic_an.nc 

  FIR 7-9 Sx_BT_in.nc Geodetic_in.nc 
  F 1,2 Fx_BT_in.nc Geodetic_in.nc 
OLCI FR / L2 OGVI 1 Default: ogvi.nc Geo_coordinates.nc 
  OTCI 1 Default: otci.nc Geo_coordinates.nc 
SLSTR FR / L2 LST 1 Default: lst.nc Geodetic_in.nc and 

flags_in.nc 
S3-Marine 
OLCI FR / L1 Radiance 01-21 Oa_xx_radiance.nc Geo_coordinates.nc 
 FR / L2 Reflectan

ce 
01-12, 16-
18, 21 

Oa_xx_reflectance.nc Geo_coordinates.nc 

  Chl open 
water 

1 Default: chl_oc4me.nc Geo_coordinates.nc 

  KD490-
open 
water 

1 Default: trsp.nc Geo_coordinates.nc 

  Chl-
complex 
water 

1 Default: chl_nn.nc Geo_coordinates.nc 

  ADG443- 
complex 
water 

1 Default: iop_nn.nc Geo_coordinates.nc 

  TSM-
complex 
water 

1 Default: tsm_nn.nc Geo_coordinates.nc 

  SST-skin 1 **_GHRSST_SSTskin_
** 

none 

 
Where: 
 xx = band number 
 **  = date and / or orbit number information 
 
 
Before starting the exercises, ensure that sample data required is locally available and unzipped, 
eventually download Sentinel data according to your requirements and for Sentinel 3 also the respective 
geo-coding layers. See chapter 2.5 for further details. 
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4.2 HANDS-ON EXERCISES USING ILWIS 

Below a concise description of exercises to be conducted is given, before your start create an output 
directory, here “d:\eo4sd_exercise” is used.  
 

4.2.1 Sentinel 1 

Import / visualization of S1A / S1B Radar Level 1C GRD images (IW-GRD-HR-L1): 
 
Open the EO4SD toolbox, select the options “Sentinel 1” > “Sentinel 1A / B L1C GRD”, from the sub 
menu, complete the import settings, both for vv and vh polarization. The sample file is located under 
/EO4SD_sampledata/S1, for the input directory continue to navigate to the sub directory /measurement. 
You find the two files with different polarization, a vv polarized and vh cross-polarized image. Import 
both images, using as output file format ILWIS. After import you can close the Toolbox menus. 
 

Figure 15: Toolbox sub menu to import Sentinel 1 images 

 
Upon completing the import (note the progress bar), open ilwis 385. Navigate to the output directory 
defined in the previous step, here d:\EO4SD_exercise. Display the images, using a gray scale 
Representation and using an appropriate stretch: 
 

 Double click the map “s1_vh”, from the left hand menu, use the ‘expand’ option in front of the 
map layer name, do the same for the option “Display Tools” > “Portrayal” > “Representation”, 
double click the Representation and select “Gray” as Representation, press “Apply” > “Close”. 

 Select from the “Display Options” > “Stretch”, now type as ‘upper stretch’, instead of the default 
value 32767, the value 300, and press OK. 

 From the map window menu press the option “Add Map”, add the map “s1_vv”, also use Gray 
colour representation and stretch also from 0 to 300. 

 Activate the option “Transparency”, drag the slide bar from 0 to 100 % and back to compare 
the difference between the ‘vh’ and ‘vv’ polarized images. 

 
 Position the centre of the image at the boundary between water and land, from the map window 

menu, select “Options”, > “No Zoom”. From the map window menu press the option “Add Map”, 
from the dropdown button on the right hand of the Filter menu, select instead of “all”, the layer 
“Base maps” > “openstreetmap” and press OK. Note that internet connection is required as the 
map is obtained online! Open the Display options under “openstreetmap”, use different 
“Transparency” settings, zoom in at different locations on the image and unselect the layer 
s1_vv (to see the layer below, here “s1_vh”). Check carefully the geometry of the image / map 
and the effect of the polarization/ backscatter, also check the image values given in the lower 
left hand corner of the map display. Try to identify the satellite pass direction, ascending or 
descending pass direction. Also try to identify different land cover types, using openstreetmap 
as your ground truth.  
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Before you continue, create a sub-map. Zoom in to the approximate area as given in the figure below. 
From the map menu, select the options “File” > “Create” > “Submap”, as raster map specify “s1_vh”, as 
output raster map specify “s1_vhsub” and press “Define”. Repeat the procedure for the other 
polarization, call the output map ”s1_vvsub”. Display both images.  
 
You will note that visualization is not optimal, conduct a stretching operation: from the ilwis main menu, 
select the options “Operations” > “Image processing” > “Stretch”, as input raster map specify “s1_vvsub”, 
as output map “s1_vvsubs”, and press “Show”. Repeat the procedure for the map “s1_vhsub” and create 
as output map “s1_vhsubs” 
 
Conduct Speckle filtering. Given random noise speckle filtering is often required to improve visual 
interpretation as well as computer assisted classification: 

 Apply ‘STD’ filter for the vv and vh polarized images: from the ilwis main menu, select the options 
“Operations” > “Image processing” > “Filter”, as input raster map specify “s1_vvsubs”, as filter 
type select “STD”, apply a 5 rows by 5 columns filter dimension, as output raster specify 
“s1_vvsubs_std”, as Domain select “Image” and press show. Navigate with your cursor over the 
image keeping the left mouse button pressed, check the values. Repeat the procedure for the 
image “s1_vhsubs” and create as output map “s1_vhsubs_std”. Check the values for water, 
compared to those on land, what is a good threshold to separate water from land? 

 Display the results including openstreetmap as transparent layer. 
 Display the map “s1_vhsubs_std” once more, from the “Display Options”, select “Interactive 

Representation”. Use 2 classes, move the slide bar up and down (increasing dark green versus 
light green and vice versa), and try to determine a good threshold which separates water from 
land. Repeat the procedure for the map “s1_vhsubs”, can you also define a good threshold or 
is the backscatter from water mixing with those on land? 

A composite RGB (colour) image can also be created, e.g. using the VV channel for red, VH channel 
for green and the ratio |VV| / |VH| for blue. First the ratio image needs to be calculated. On the ilwis 
command line type the following expression: 

 s1_ratio:=s1_vvsubs_std/ s1_vhsubs_std 

As domain select “Value”, keep other settings as their defaults and press OK. As last step also stretch 
this map. From the ilwis main menu, select the options “Operations” > “Image processing” > “Stretch”, 
as input raster map specify “s1_ratio”, as output map “s1_ratios”, and press “Show”. 

Now in the ilwis command line type: mapcolorcomp and in the color composite menu, for Red specify 
“s1_vvsubs_std”, for Green specify ”s1_vhsubs_std” and for Blue specify “s1_ratio” and as output map 
“s1_fcc”, press “Show”. Try to determine how many land use / land cover classes can be defined. 

Continue with some unsupervised image classification, here we apply the ‘Cluster’ method, based on 7 
classes. From the ilwis main menu, select the options “Operations” > “Image processing” > “Cluster”, 
use two input maps, as input raster map 1 specify “s1_vvsubs_std”, as input raster map 2 specify 
“s1_vhsubs”, as number of clusters “7”as output map “cluster7”, as Output Table “”cluster7, and press 
“Show”. 
 
Once the result is displayed, from the “Display Tools”, select the option ”Portrayal” > “Fixed Colors” > 
“Multiple Colors” and use the “default” color scheme, for a “7” size color set, click “Apply” and “Close”. 
Review your results, use also the color composite created “s1_fcc” and “openstreetmap”. Open the table 
created “cluster7” and check the statistics calculated. The results should resemble those given in the 
figure below. You have created 7 clusters, try to assign names to the clusters identified! Use 
openstreetmap as your ground thruth. 
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Figure 16: Results of the Sentinel 1 radar image processing 
 
Map 1: resulting color composite (r=vv, g=vh, b=ratio vv/vh) 

Map 2: open street map of the area selected 

 
Map 3: result of the cluster operation, showing 7 classes 
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4.2.2 Sentinel 2 

Now we continue with the import / visualization of Sentinel 2 MSI Level 1C images (S2-MSI-L1C).In the 
sample data directory the data is available at: D:\EO4SD_SampleData\S2\L1\S2A_MSIL1C_ 
20170215T105121_N0204_R051_T31UFU_20170215T105607.SAFE\GRANULE\L1C_T31UFU_A00
8628_20170215T105607\IMG_DATA. Note the various bands, also inspect their file sizes. Note the TCI 
image as well. 
 
Open the EO4SD Toolbox, from the main menu select the options “Sentinel 2” > “Level 1” > “Sentinel 
2A / B L1C MSI Bands”. Import the 10 meter resolution images from bands 2, 3, 4 and 8 (b,g,r,nir 
respectively). See also the figure below showing the settings to import band-2. 
 

Figure 16: Toolbox sub menu to import Sentinel 2 L1C images 

 
 
 

Ensure that the four 10 meter resolution bands have been imported, here as file names msi_b2, msi_b3, 
msi_b4 and msi_b8 are used. Upon completion close the toolbox and open ilwis. Navigate to the output 
directory as specified in the toolbox. 
 
To display msi_b2, right-click with the mouse on the image “msi_b2”, from the context sensitive menu 
select the options “Statistics” > “Histogram” and press “Define”. Inspect the 1 and 99 % data values and 
close the histogram. Double click the image “msi_b2”. From the left hand menu, use the ‘expand’ option 
in front of the map layer name, do the same for the option “Display Tools” > “Portrayal” > 
“Representation”, double click the Representation and select “Gray” as Representation, press “Apply” > 
“Close”. 
 
Select from the “Display Options” > “Stretch”, now type as ‘lower stretch’ the value “1095” and as ‘upper 
stretch’ the value “2301”, and press OK. Check the image, also use openstreetmap as transparent layer. 
Eventually zoom in to get a better idea about the geometry of the image, check the coordinates at the 
lower right window, note these are UTM coordinates as well as Lat-Lon coordinates! Also note the image 
values, these are 16 bits integer values. 
 
To improve the visualization the imported bands have to be stretched. From the ilwis main menu, select 
the options “Operations” > “Image processing” > “Stretch”, as input raster map specify “msi_b2”, as 
output map “msi_b2s”, and press “Show”. 
 

 Repeat this procedure for the other 3 bands, call them msi_b3s, msi_b4s and msi_b8s 
respectively 

 Create a natural colour composite using the b, g, and r stretched bands. Now in the ilwis 
command line type: mapcolorcomp and in the color composite menu, for Red specify “msi_b4s”, 
for Green specify ”msi_b3s” and for Blue specify “msi_b2s” and as output map “s2_ncc”, press 
“Show”.  

 Create a false colour composite using the g, r, and nir stretched bands. Now in the ilwis 
command line type: mapcolorcomp and in the color composite menu, for Red specify “msi_b8s”, 
for Green specify ”msi_b4s” and for Blue specify “msi_b3s” and as output map “s2_fcc1”, press 
“Show”.  
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 Create a false colour composite using the b, g, and nir stretched bands. Now in the ilwis 
command line type: mapcolorcomp and in the color composite menu, for Red specify “msi_b8s”, 
for Green specify ”msi_b3s” and for Blue specify “msi_b2s” and as output map “s2_fcc2”, press 
“Show”. Your results should resemble those given in the figure below, left image is the ncc, 
centre image is fcc1 and right imageis fcc2. 
 

Figure 17: The 10 meter resolution SMI – Level 1C colour composites created 
 

 
 Explain the differences in colour, use also the information as given in figure 5 and combine it 

with your knowledge of spectral characteristics over the various parts of the electromagnetic 
spectrum of different cover types. Use openstreetmap to obtain your ground truth. Why so many 
different colorations of the water bodies and which composite is showing most information on 
these water bodies? 

 
To import the 20 meter resolution images select bands 5, 6, 7, 8a, 11 or 12. To import the 60 meter 
resolution images select bands 1, 9 or 10. The same procedure as described above can be applied, 
selecting appropriate bands to make the composite! Note also figures 6 and 7. 
 
Continue to import a True Colour Image (TCI) of Level 2. This image was directly downloaded from the 
Copernicus Science Hub. Use the settings as given in the figure below and wait until progress bar 
indicates that product is imported, close the sub menu.  
 

Figure 18: S2-MSI – Level 2 TCI import of image 20170526 

 
After import calculate for each band the histogram, from the ilwis main menu, select the options 
“Operations” > “Image processing” > “Stretch”, as input raster map specify “s2_msi_tci_l2_band_1”, as 
output map “msi_tci_b1s”, and press “Show”. 
 

 Repeat this procedure for the other 2 bands, call them msi_tci_b2s, msi_tci_b3s respectively. 
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 Create a natural colour composite using the b, g, and r stretched bands. Now in the ilwis 
command line type: mapcolorcomp and in the color composite menu, for Red specify 
“msi_tci_b1s”, for Green specify ” msi_tci_b2s” and for Blue specify “msi_tci_b3s” and as output 
map “s2l2_tci_may”, press “Show”. 

 Display the colour composite, add the natural colour composite created before, here “s2_ncc”, 
use for the top layer map in the left hand legend, under “Display Options” the option 
“Transparency”, zoom in and note the changes. 

 Note that the date of the images is for the map ‘s2_ncc’ 20170215, for the map ‘s2l2_tci_may’ 
the recording date is 20170526. 

 
Finally import another MSI data set. This data has been recorded on 20171217.  Open the EO4SD 
toolbox and from the menu select the options “Sentinel 2” > “Level 1” > “Sentinel 2A / B L1C MSI Bands”. 
From the sub-menu use the following settings as given in the figure below. Note the full path to the 
source data is: D:\EO4SD_SampleData\S2\L2\S2B_MSIL2A_20171217T105439_N0206_R051_ 
T31UFU_20171217T125559.SAFE\GRANULE\L2A_T31UFU_A004081_20171217T105433\IMG_DA
TA\R10m. 
 

Figure 19: S2-MSI – Level 2 TCI import of image 20171217 
 

 
 
 

 After import calculate for each band the histogram, right click using the mouse the file, here 
“s2l2_tci_band_1”, select the options “Statistics” > “Histogram” and press “Show”. Inspect the 
histogram values and repeat the procedure for the other two bands. 

 
 From the ilwis main menu, select the options “Operations” > “Image processing” > “Stretch”, as 

input raster map specify “s2l2_tci_band_1”, as output map “s2l2_tci_band_1s”, and press 
“Show”. Repeat the procedure for the other two bands and call them “s2l2_tci_band_2s” and 
“s2l2_tci_band_3s” respectively 

 
 Create a natural colour composite using the b, g, and r stretched bands. Now in the ilwis 

command line type: mapcolorcomp and in the color composite menu, for Red specify 
“s2l2_tci_band_1s”, for Green specify ” s2l2_tci_band_2s” and for Blue specify 
“s2l2_tci_band_3s” and as output map “s2l2_tci_dec”, press “Show”. 
 

In the image map window add the maps ‘s2_ncc’ and the map ‘s2l2_tci_may’.Use the “Transparency 
options” of the two top layers, or uncheck the layer to note the differences between them. Zoom in on 
the centre southwest (called de Markermeer), just south of the enclosure dam and note the progress in 
the reclamation of a new island, see also the figure below. Further information can be found at: 
https://en.wikipedia.org/wiki/Marker_Wadden.  
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Figure 20: Reclamation progress of the Marker Wadden in 2017 

 
To conclude the exercise using MSI now import from the MSI level-2 20 meter resolution data set the 
scene classification “SCL” product.  
 
Open the EO4SD Toolbox, from the main menu select the options “Sentinel 2” > “Level 2” > “Sentinel 
2A / B L2 MSI TCI”. Import from the 20 meter resolution folder the product called “SCL”. Note the folder:  
D:\EO4SD_SampleData\S2\L2\S2B_MSIL2A_20171217T105439_N0206_R051_T31UFU_20171217T 
125559.SAFE\GRANULE\L2A_T31UFU_A004081_20171217T105433\IMG_DATA\R20m. Specify the 
import settings as given in the figure below and wait till the import is completed. 
 

Figure 21: Import of the scene classification product MSI-L2 

 
 
Open the map “scl” and inspect the map values. Note the legend as given at the end of chapter 2.3. In 
your sample data directory navigate to the folder ‘\ilwis_service_objects’ and copy the four files 
(s2l2_scl.rpr, s2l2_scl.rp#, s2ls_scl.dom and s2l2_scl.dm#) to your working directory (here 
‘D:\eo4sd_exercise’). 
 
To transform the map numbers into classes, according to the legend, perform the following operation: 
from the ilwis main menu, select the option “Operations” > “Image Processing” > “Slicing”, as input map 
specify “scl”, as output map “scl_cl” and as domain “s2l2_scl” and press “Show”. Under the display 
options, as part of the ‘Representation’ the legend can be observed. With the feft mouse button pressed 
over the map the class information can be obtained. Also display the December colour composite 
created before and compare the image with the classes differentiated. See also the figure below. Note 
that a few days before the south east part was affected by snow and still remnants are visible! 
 
You can also compare this classification with the one created based on the cluster procedure for Sentinel 
1 for a subset of this window as conducted in the previous exercise.  
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Figure 22: The scene classification and the true colour composite 
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4.2.3 Sentinel 3 Land 

For Sentinel 3 ESA provides the data over land and EUMETSAT is responsible for the marine data 
provision derived from the OLCI and SLSTR instruments. It should be noted that for all Sentinel 3 data 
the coordinate information is stored as a separate layer in the “SAFE” container. It can also be 
downloaded as a separate file from the data archives. Check once more table 6 before you continue. 
Also in the sub-menu heading the input files required for data import are given (see ‘Typical Filename’). 
 
In the exercise below an import will be conducted of the OLCI Level 1 Radiance data, note the data is 
available at: D:\EO4SD_SampleData\S3\level1\land\S3A_OL_1_EFR____20170502T091731_ 
20170502T092031_20170502T111511_0179_017_150_1979_SVL_O_NR_002.SEN3.  
 
Open the EO4SD Toolbox, from the main menu select the options “Sentinel 3 - Land” > “Level 1” > 
“OLCI” > “Radiance 01 - 21”. See also the figure below showing the settings to import band-4 from the 
sub menu. 

 
Figure 23: Import OLCI Level 1 Band 4 Radiance 

 
 
 
Open ilwis and display the map “s3_land_radb4”, Open “Display Option”, under “Representation” select 
“Gray”, under the “Stretch” options, use as upper limit “85”. Check the map values. Eventually add 
openstreetmap. Note the geometry of the image. At the top of the map display window  the syntax is 
displayed how the image is calculated, note the scaling and offset applied. These are different for the 
various radiance channels. 
 
Eventually import some of the other channels, like band 6 and band 7 and display the maps, note the 
scaling coefficient applied. Check which part of the Electro Magnetic spectrum is recorded for each of 
the channels. 
 
Create a colour composite of a subset of the map (for cloud free area). Copy and paste the syntax 
presented below, line by line, in the command line of the ilwis main menu, press enter to execute the 
expressions. Fist a sub-map is created, then the map is stretched, finally a colour composite is created: 
 
s3_land_rad4_sub.mpr:=MapSubMap(s3_land_radb4,1122,1248,1391,2472) 
s3_land_rad6_sub.mpr:=MapSubMap(s3_land_radb6,1122,1248,1391,2472) 
s3_land_rad7_sub.mpr:=MapSubMap(s3_land_radb7,1122,1248,1391,2472) 
 
s3_land_rad4_subs.mpr{dom=image.dom;vr=0:255}:=MapStretchLinear(s3_land_rad4_sub,1.000000,
image.dom) 
s3_land_rad6_subs.mpr{dom=image.dom;vr=0:255}:=MapStretchLinear(s3_land_rad6_sub,1.000000,
image.dom) 
s3_land_rad7_subs.mpr{dom=image.dom;vr=0:255}:=MapStretchLinear(s3_land_rad7_sub,1.000000,
image.dom) 
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s3_land_cc.mpr=MapColorComp24Linear(mlist(s3_land_rad7_subs,s3_land_rad6_subs,s3_land_rad
4_ subs),1.000000,1.000000,1.000000) 
 
The resulting colour composite should resemble the figure given below, note the red coloured segments 
for the country boundaries are added to show the geometry of the image. 
 

Figure 24: Colour composite of OLCI Level 1 over the Scandinavia 
 

 
 
 
In the exercise below an import will be conducted of the OLCI Level 1 Radiance data, note the data is 
available at: D:\EO4SD_SampleData\S3\level1\land\S3A_SL_1_RBT____20171218T212050_ 
20171218T212350_20171220T014716_0179_025_357_6779_LN2_O_NT_002.SEN3.  
 
Open the EO4SD Toolbox, from the main menu select the options “Sentinel 3 - Land” > “Level 1” > 
“SLSTR” > “TIR”. See also the figure below showing the settings to import S7 from the sub menu. 
 

Figure 25: Import thermal channel SLSTR 

 
 
Open the map “s3_land_s7bt”, inspect the map values, note that a Kelvin scale is used! Eventually add 
“openstreetmap”. Note the temperatures for the different cover types, e.g. land, water, snow, clouds. 
How to remove the cloud cover from the image? 
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Open the EO4SD Toolbox, from the main menu select the options “Sentinel 3 - Land” > “Level 2” > 
“SLSTR” > “LST”. See also the figure below showing the settings to import the LST product from the 
sub menu, note the default name is already given. 
 
The full path name to the products is: D:\EO4SD_SampleData\S3\level2\land\S3A_SL_2_LST____ 
20171206T100908_20171206T101208_20171206T121557_0179_025_179_2160_SVL_O_NR_002.S
EN3. 
 

Figure 25: Import SLSTR Level 2 LST product 

 
 
Display the map “lst”, also note that a map “lst_flags” has been created. Also display this map and note 
the map values (of both maps). 
 
Apply for the LST product the extracted cloud mask: 
 

 Note that with respect to the flag mask, this layer is imported with same name as the LST image, 
but is having as suffix ‘_flags’ 

 To apply flags mask, all cloud flags in the map have a value greater than 1, 1 is the non-clouded 
area, the area outside the image (note the image is wrapped) is 0. The following map calculation  
statements can be applied: 

 
Flag_fin:=iff(lst_flags = 1,255,0) 
Lst_cor_flags:=iff(flag_fin=255,lst,?) 

 
 These operations assign NaN to the cloud contaminated pixels as well as those outside the 

map. The pixels, having the value of 1, reclassified into 255 (for better visualization if the mask 
is displayed) will be assigned the LST value in the output map. 
 

Your results should resemble those given in the picture below. 
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Figure 26: Application of cloud mask on the LST product 

 
 

Finally we are going to retrieve OLCI Level 2 products, like the OGVI and the OTCI (see table 3). Open 
the EO4SD Toolbox, from the main menu select the options “Sentinel 3 - Land” > “Level 2” > “OLCI” > 
“OGVI”. See also the figure below showing the settings to import the OGVI product from the sub menu, 
note the default name is already given. 
 
The full path name to the products is: D:\EO4SD_SampleData\S3\level2\land\S3A_OL_2_LFR____ 
20170814T092115_20170814T092415_20170815T144543_0179_021_093_1980_LN1_O_NT_002.S
EN3. 
 

Figure 27: Import OLCI vegetation product - OGVI 

 
Open ilwis and display the map “ogvi”, open “Display Options”, under “Representation” select “NDVI1. 
Check the map values. Eventually add openstreetmap. Note the geometry of the image. At the top of 
the map display window  the syntax is displayed how the image is calculated, note the scaling and offset 
applied. Repeat the import procedure and now select the ‘otci’ product and display the resulting map 
“otci”, use as representation “lai”, check the map values and eventually display also openstreetmap. 
Your results should resemble those of the figure below. 
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Figure 27: OLCI vegetation products – OGVI (left) and OTCI (right) 

 

4.2.4 Sentinel 3 Marine 

For the marine service the data has been retrieved from the Copernicus Online Data Access portal. Also 
here level 1 and level 2 products are available. The import routine to retrieve the data is identical to 
those provided in the previous chapter. Here we are going to look at some of the level 2 products, 
derived from OLCI and SLSTR. 
 
Open the EO4SD Toolbox, from the main menu select the options “Sentinel 3 - Marine” > “Level 2” > 
“SLSTR – SST Skin”. See also the figure below showing the settings to import the SSTskin from the sub 
menu. 
 
Note the full path to the data folder is: D:\EO4SD_SampleData\S3\level2\marine\S3A_SL_2_WST____ 
20171228T113904_20171228T114204_20171228T124833_0179_026_108_5759_MAR_O_NR_002.
SEN3. 
 
 

Figure 28: Import SST Skin Temperature  

 
Display the map “sstskin”. Calculate also the histogram and study the histogram visualization in detail 
(also given here). You will note a bimodal distribution, the left distribution 
centred around 283 K and the right distribution around 290. The left 
distribution is representative of the “Black Sea” area and the right one is 
representing the “Mediterranean Sea”. To get a better idea of the skin 
temperature of the Mediterranean waters, apply the following equation: 
 

sstkin_med:=iff((sstskin>287) and (sstskin<293),sstskin,?) 
 

Display the map “sstskin_med” using the default representation. Your results 
should resemble those given in the figure below. 
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Figure 29: SST Skin Temperature Mediterranean Sea 

 
 
 

Now continue importing some of the OLCI Level 2 products. The full path name to these products is: 
D:\EO4SD_SampleData\S3\level2\marine\S3A_OL_2_WFR____20180101T103819_20180101T1041
19_20180102T171032_0180_026_165_2339_MAR_O_NT_002.SEN3. 
 
 Open the EO4SD Toolbox, from the main menu select the options “Sentinel 3 - Marine” > “Level 2” > 
“OLCI – TSM Complex Water”. Use the default product name if this is given in the import sub-menu. 
The sub menu is given below using as example the “Total Suspended Matter” product. 
 
 

Figure 29: Import OLCI Level 2 TSM Marine Product 

 
 

Display the map “tsm”, add openstreetmap and zoom in along the coastal areas and note the patterns 
of the suspended matter. Eventually import some of the other products, check table 4 for details on the 
variables. Note the default input filename is already given. Close ilwis before you continue. 
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4.3 HANDS-ON EXERCISES USING QGIS 

 
Before already a large number of examples are given how to import the various images and products 
from the Sentinel family of satellites. Here the focus is on the visualization using QGIS. As you have 
noticed within the sub-menu as output also QGIS can be selected. An output map is created in a GeoTif 
format and the data outside the image window is mostly assigned to -999. In the example below a 
Sentinel2 level 1 MSI TCI is going to be extracted and visualized. 
 
  
Open the EO4SD Toolbox, from the main menu select the options “Sentinel 2” > “Level 1” > “Sentinel 
2A / B L1C MSI TCI”. See also the figure below showing the settings to import the TCI. The full path to 
the data source is: D:\EO4SD_SampleData\S2\L1\S2A_MSIL1C_20170215T105121_N0204_R051_ 
T31UFU_20170215T105607.SAFE\GRANULE\L1C_T31UFU_A008628_20170215T105607\IMG_DA
TA 

 
Figure 30: Toolbox sub menu to import Sentinel 2 L1 TCI in QGIS 

 
 

Open QGIS, here version 2.14 (Essen), from the main menu, select the options “Layer” > “Add Layer” 
> “Add Raster Layer”, select the image “tciq.tif” and press “Open”. Double click on the “tciq.tif” layer in 
the left hand legend, from the Style properties menu select the option “Transparency” and for “additional 
no data value” enter “0” and click “Apply”. Now note that the NE part of the image is displayed in 
transparency mode. 
 
Select the option “Histogram” from the layer properties and press the button “Compute Histogram”, now 
modify the “Set min/max style for band 1”, use the ‘hand-sign’ marking tool and select a minimum value 
(here around 33) and a maximum value (here around 170) from the red curve, repeat this procedure for 
bands 2 and 3 (for the green and blue curves respectively and selection of the appropriate minimum 
and maximum. Finally press apply. Open the “Style” option, note the minimum and maximum settings 
for each of the band, see also the figure below, and click “Apply”. Close the “Style Properties” menu and 
zoom in on the image. Select the area around Schiphol International Airport in the south west corner of 
the image. 
 
Now from the main menu, select the options “Vector” > “Openstreetmap” > “Download data..” (note that 
internet connection is required!), activate the option “From Map Canvas”, specify an Output file, navigate 
to the working directory and specify an output name, here e.g. “D:/eo4sd_exercise/schiphol.osm” and 
press “OK”. A message will popup when downloading has been conducted successful, press “OK” and 
“Close” the Download OpenstreetMap Data menu. Be modest and select only a small area! 
 
Now from the main menu, select the options “Vector” > “Openstreetmap” > “Import Topology from XML”, 
specify the input XML, here “Schiphol.osm”, accept the default Output SpatiaLite DB file and press “OK” 
Accept the message and close the window. 
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Now from the main menu, select the options “Vector” > “Openstreetmap” > “Export OpenStreetMap 
Topology to SpatialLite”, select as input DB file: “schiphol.osm.db”, as Export type select the option 
“Polygons (closed ways)”, use default output name, here “Schiphol_polygons” and under Exported tabs, 
press the button “Load from DB”, as ‘Tag’ activate the “building” and press “OK”. 
 
The polygons are added to the map display window, double click on the layer “Schiphol_polygons”, 
activate the option “Style”, as “Fill”, use “Simple Fill”, and from the right hand  “Symbol layer type”, under 
“Colors”, select from the Fill dropdown menu the option “Transparent fill”  and as “Border” select the 
colour “white”, finally press “Apply” and “OK”.  Eventually zoom in further to check the accuracy of the 
overlay of the raster and the vector data. Your results should resemble those presented below. 
 

Figure 31: Schiphol international airport and OSM vector overlay 

 
 
 

Note that for the other images or products imported the histogram needs to be adjusted in a similar 
manner as indicated above, most other products use -999 for “no data”, be sure the histogram is 
correctly representing your data range. 
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5. USING THE SENTINEL APPLICATION PLATFORM – SNAP 

5.1 PROCESSING OF SENTINEL-1 GRD EXAMPLE FROM ETHIOPIAN HIGHLANDS 

Ensure that SNAP is installed and that your system is online. The exercise requires (automatic) 
download of orbit information and SRTM Elevation data. The sample input file required to conduct this 
exercise is:  
 

 S1A_IW_GRDH_1SDV_20171206T030912_20171206T030937_019576_0213F2_FFCF.SAFE 
 
Sequence of processing steps to be performed using SNAP: 
 

 Opening a product, reading of the data, using the xml file  
 Visualizing the VH and VV polarized data 
 Data calibration 
 Data filtering – apply ‘Refined Lee’ speckle filter 
 Terrain correction Data Geocoding 
 Export Dimap format results obtained to be used in other free software tools, like ILWIS 

 
Before you are going to use SNAP, first have a look within the *.SAFE file container. Navigate to the 
sample data directory SNAP_S1\Ethiopia\S1A_IW_GRDH_1SDV_20171206T030912_20171206T 
030937_019576_0213F2_FFCF.SAFE\preview. Double click the quick-look.png and also display the 
file “map-overlay.kml”, which will start a google earth session and displays the quicklook, also see the 
figure below. Note that the product is ‘ground range detected (GRD)’, the pass direction is descending 
and the instrument is right looking with respect to the flight direction. 
 

Figure 32: S1A quick-look image of Ethiopia 
 

 

5.2 STARTING A SNAP SESSION AND OPENING A PRODUCT 

From the Windows menu, under ESA SNAP, select the option “SNAP Desktop”. From the “Menu” > 
“Open Product”, navigate to the sample data directory, here ‘D:\EO4SD_SampleData\ 
SNAP_S1\Ethiopia\S1A_IW_GRDH_1SDV_20171206T030912_20171206T030937_019576_0213F2_
FFCF.SAFE’ the file ‘manifest.safe’. The data is added to the “Product explorer”. Expand the product by 



41 

 

clicking the ‘+’ sign in front to the product name, repeat this for the Meta Data and check the content, 
especially the Abstracted_Metadata. 
 
Expand the Product ‘Bands’ layer and double click on the entry “Amplitude_VH”, eventually zoom and 
check the image amplitude of the various cover types. Repeat this procedure for “Amplitude_VV”. 
Display also the virtual Intensity images, e.g. of the VH polarized image. Note the intensity is calculated 
as:  Amplitude_VH * Amplitude_VH. Your result should look like the “amplitude_HV” image displayed in 
the figure below. Also check the coordinates assigned, provided in the lower right. 
 
Next to the “Product Explorer” Tab also the “Pixel Info” Tab is available, open this Tab and move the 
cursor over the map and inspect the information provided. 
 

Figure  33: SNAP Menu providing Product Explorer and selected image displayed 

 
 
Question: Compare the quick-look image provided in the figure above and the S1A Amplitude_VH 
image. What can you remark about the geometry and can you explain why? Are you able to differentiate 
a few main image features, like hills, towns, water bodies, etc? You might need to zoom in to display 
the full resolution image details. 
 

5.3 APPLY ORBIT FILE 

The orbit state vectors provided in the metadata of a SAR product are generally not accurate and can 
be refined with the precise orbit files which are available days-to-weeks after the generation of the 
product.  The orbit file provides accurate satellite position and velocity information. Based on this 
information, the orbit state vectors in the abstract metadata of the product are updated. For Sentinel-1, 
restituted orbit files and precise orbit files may be applied. Precise orbits are produced a few weeks after 
acquisition  

From the SNAP menu, select the option “Radar” > “Apply Orbit File”, define the input and output file 
names, use the default names and output file format, note that you might want to store it in a different 
folder. Execute the operation and display the new ‘*_Orb’ product generated using the updated orbit 
information. 
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5.4 RADIOMETRIC CALIBRATION 

The objective of SAR calibration is to provide imagery in which the pixel values can be directly related 
to the radar backscatter of the scene. Though uncalibrated SAR imagery is sufficient for qualitative use, 
calibrated SAR images are essential to quantitative use of SAR data.  

Typical SAR data processing, which produces level 1 images, does not include radiometric corrections 
and significant radiometric bias remains. Therefore, it is necessary to apply the radiometric correction 
to SAR images so that the pixel values of the SAR images truly represent the radar backscatter of the 
reflecting surface. The radiometric correction is also necessary for the comparison of SAR images 
acquired with different sensors, or acquired from the same sensor but at different times, in different 
modes, or processed by different processors.  Although only a single image is used here, radiometric 
calibration of the image will be conducted. 

From the SNAP menu, select the option “Radar” > “Radiometric” > “Calibrate”, define the input (the 
image file obtained during the previous step, indicated as layer [2]) and output file names, use the default 
output name and output file format. Also check the “Processing Parameters” Tab. Execute the operation 
and display the new ‘*_Cal’ product generated. 
 

5.5 SPECKLE FILTERING 

SAR images have inherent salt and pepper like texturing called speckles which degrade the quality of 
the image and make interpretation of features more difficult. Speckles are caused by random 
constructive and destructive interference of the de-phased but coherent return waves scattered by the 
elementary scatters within each resolution cell. Speckle noise reduction can be applied either by spatial 
filtering or multilook processing. 
 
SNAP supports a few different filter types. From the SNAP menu, select the option “Radar” > “Speckle 
Filtering” > “Single Product Speckle Filter”, define the input (the image file obtained during the previous 
step, indicated as layer [3]) and output file names, use the default output name and output file format. 
Open the Tab “Processing Parameters” and as “Filter” selected “Refined Lee”. Execute the operation 
and display the new ‘*_Spk’ product generated. 
 

5.6 TERRAIN CORRECTION 

The image is still in ground range detected geometry, note that still ‘Eastings’ is flipped. Next to this the 
image requires elevation information for appropriate geometric (ortho) rectification. Due to topographical 
variations of a scene and the tilt of the satellite sensor, distances can be distorted in the SAR images. 
Image data not directly at the sensor’s Nadir location will have some distortion. Terrain corrections are 
intended to compensate for these distortions so that the geometric representation of the image will be 
as close as possible to the real world. 

The Range Doppler Terrain Correction Operator implements an orthorectification method for geocoding 
SAR images from single 2D raster radar geometry. It uses available orbit state vector information in the 
metadata, the radar timing annotations, the slant to ground range conversion parameters together with 
the reference DEM data to derive the precise geolocation information. The STRM v.4 (3” tiles) from the 
Joint Research Center FTP (xftp.jrc.it) is automatically downloaded in tiles for  the area covered by the 
image to be orthorectified. The tiles will be downloaded to the folder 
.snap\AuxData\DEMs\SRTM_DEM\tiff. The .snap folder is located in your user folder.   

If you are working offline or with low bandwidth connection, copy the SRTM DEM tiles required from the 
sample data folder \EO4SD_SampleData\SNAP_S1\Ethiopia\srtm4_dem to C:\Users\’yourname’\ 
.snap\auxdata\dem\SRTM 3Sec. 

From the SNAP menu, select the option “Radar” > “Geometric” > “Terrain Correction” > “Range-Doppler 
Terrain Correction”, define the input (the image file obtained during the previous step, indicated as layer 
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[3]) and output file names, use the default output name and output file format. Open the Tab “Processing 
Parameters” and note the DEM selected as well as the resampling method. Execute the operation and 
display the new ‘*_TC’ product generated and note the effects on the geometry of the image! See also 
the figure below. 

Figure 34: Terrain corrected VV polarized image displayed showing Addis Ababa and Int’l 
Airport 

Note that the file has become very large. To continue working a subset will be created. From the main 
menu select “Raster” > “Subset”, note that you will create a spatial subset, Enter the following scene 
subset details: scene start X: 4608,  scene start Y: 5184, scene end X: 9216 and scene end Y: 8832, 
press OK. Display the subset of the two polarizations. 

To view the image in decibel scaling, right-click on the terrain corrected Sigma0_VH band and select 
Linear to/from dB and confirm to convert the data using a new virtual band. Display the new virtual band 
created (“Sigma0_VH_db”). Repeat the procedure for the VV polarized product as well. Right click the 
layer “Sigma0_VH_db” and select the option “Band Maths…” and specify as name “Intensity_VH_db”, 
uncheck the option “Virtual” and press OK. Note that now a real layer has been created. Display the 
layer and repeat the procedure for the and create a real layer for the VV polarized image, assign as file 
name “Intensity_VV_db” 

Save the subset created, including the two ‘intensity’ images. Select from the main menu the options 
“File” > “Save Product As” and save it under a new filename, e.g. “Ethiopia_sub”, the output file format 
is “Dim”, and press “Save”. After the product has been saved use your windows navigator and check 
the content of the new file created (in the directory D:\snap_result, note the file “ethiopia_sub.dim” and 
the sub-directory “ethiopia_sub.data”, containing the four data layers. You can close SNAP. 

5.7 USING SNAP RESULTS IN OTHER SOFTWARE 

As example here the *.dim data will be exported to ILWIS *.mpr format using the “Import from SNAP” 
routine within the Sentinel EO4SD Toolbox. Before you continue create an new directory, e.g. 
“d:\snap2ilwis” 
 
Within the EO4SD_py directory, right click the file “EO4SD_start.py” and open the file with IDLE. Press 
F5 and the Python Shell and toolbox menu appear. From the toolbox menu select the option “Import 
from SNAP” > “Generic SNAP – DIMAP Import”. In the Python shell specify the input file, here 
“Intensity_VH_db”, press <enter>, use the same name as output file name, press <enter>, as SNAP 
Data Directory, press <enter>, finally select the sub-directory where you have stored your ‘intensity’ file, 
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here “D:\snap_result\ethiopia_sub.data” and finally enter your Working Directory, here “d:\snap2ilwis” 
and press <enter> once more to execute the operation. Repeat the procedure for “Intensity_VV_db” 
image.  
 
After the import is completed open ILWIS385 and navigate to the folder “d:\snap2ilwis”. Display the two 
layers, change under the “Display Tools” > “Portrayal” > “Representation” to “Gray”. Open the option 
“Stretch” and move the slide bar to enhance the visualization. Close the map display.  
 
Right click in the catalog the image “Intensity_VV_db”, select the options “Image Processing” > “Stretch” 
and specify as Output map name “red” and press “Show”. Wait till the processing is completed, the 
computation of the histogram can take some time. Check the image values once the map is displayed, 
note that the data is now in byte format. 
 
Repeat the procedure for the image “Intensity_VH_db”, select the options “Image Processing” > 
“Stretch” and specify as Output map name “green” and press “Show”. 
 
Now compute the ratio image, defined as |VV|/|VH|. To do so type the following expression in the 
command line: 
 
 blue_ratio:=green/red 
 
Use the default settings and press OK. Also stretch the image “blue_ratio”, select the options “Image 
Processing” > “Stretch” and specify as Output map name “blue” and press “Show”. 

The composite RGB (colour) image to be created is using the VV channel for red, VH channel for green 
and the ratio |VV| / |VH| for blue. Press the Tab “Finder” from the left hand menu, select the operation 
“Color Composite” and use “Red” for the red band, “Green” for the green band and “blue” for the blue 
band. As output map specify “cc”. Display the resulting map “cc”. 

From the map window select the option “Add Data Layer”,  from drop down button at the filter option, 
select “Basemaps” > “OpenStreetmap” and press OK. Drag the openstreetmap layer in the legend below 
the cc-colour composite. Open the Display Tools properties of the map “cc”, which is now the top layer. 
Activate the option “Transparency” and move the slidebar. Eventually zoom into the image. Check the 
results of the terrain correction, these should resemble the figure below. 

Figure 35: Terrain corrected Sentinel-1 composite RGB (colour) image 
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Close all open programs, like ILWIS, Python and eventually SNAP, if not closed already. Check your 
working directory as you have created a large number of files which consume considerable storage 
resources. 
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6. APPENDICES 

Sample data directory structure 
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EO4SD-WATER: Quick Installation instructions of the software tools used for the workshop 

All software and resources available from ftp://ftp.itc.nl/pub/52n/EO4SD/  

Quick install EO4SD‐Toolbox and ancillary tools. 

Copy from the software or download from the FTP directory: 

 Copy EO4SD_py.zip to the root of the C:\ or D:\ drive and unzip the file 

 Copy ilwis372.zip to the root of the C:\ or D:\ drive and unzip the file  

 Copy ilwis385z.zip to the root of the C:\ or D:\ drive and unzip the file  

 Copy python34.zip to the root of the C:\ or D:\ drive and unzip the file 

 

Copy python34.dll in the python34 folder or in c:\windows\system32 (when using a 32 bits OS) or 

c:\windows\Syswow64 (when using a 64 bits OS) 

Unzip the file ‘ILWISObjects‐beta3.1‐forPython3.4‐32bit.exe.zip’, double click the executable 

(‘ILWISObjects‐beta3.1‐forPython3.4‐32bit.exe’) and install it using the default installation 

instructions. When asked about the path to ‘Python’, enter the appropriate path, e.g. c:\python34 or 

d:\python34, depending on which drive you have used to copy the directory as your software 

directory, see also instructions above. 

Because here we just use a copy of Python and do not go through a full installation procedure, your 

system still needs some modifications to run python properly. One of the main issues is to ensure 

that the path to the python executable (here python.exe and pythonw.exe) is recognized by your 

system. There are two ways to do this, using a short‐cut or modifying the environment variables of 

your system. 

1. By creating a short‐cut: 

From the \EO4SD_py directory, right click the file ‘EO4SD_start.pyw’ and select the option “create 

shortcut”. Right‐click the shortcut created, here ‘EO4SD_start.pyw ‐ Shortcut’, see also the figure 

below. 
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Now change the Target to:  

C:\python34\pythonw.exe C:\EO4SD_py\EO4SD_start.pyw 

(assuming that you have installed the “EO4SD_py” utility on the C:\ drive, else change accordingly) 

Once done, save the changes by clicking the “Apply” button. 

Within the shortcut properties you can also change the name and also add another icon, see for the 

icon your directory: \EO4SD_py\pics\esa.ico and click “Apply”.  

Eventually right‐click the shortcut created and use the option ‘Send to desktop (create a shortcut)’, 

once on the desktop you might change the name. 

 

2. By changing the system environment variables: 

Check your system “environment variables”, add to the path: ;c:\python34 or ;d:\python34 

(depending on the drive selected). To do so see also: https://helpdeskgeek.com/windows‐10/add‐

windows‐path‐environment‐variable/.  

You have to reboot your system to ensure the new variables are implemented 

To check if the path to your python folder is correctly added,  open a command window, and type: 

path  

and press <enter> 

Check if the path now includes the link to the directory of python  

If the second option is used, navigate to the directory EO4SD_py and right‐click with the mouse on 

the file “EO4SD_start.pyw” and select the option “open the file with” and navigate to the python 

folder and select the executable “pythonw.exe” 

From the directory \EO4SD_py right‐click on the file “python.exe” and create a shortcut. Within the 

shortcut properties you can change the name and also add another icon, see for the icon 

\EO4SD_py\pics\esa.ico 

Start the application “EO4SD_start.pyw” 

Note that you also may want to install SNAP and QGIS, see your software folder for the respective 

software utilities. Default installation settings can be used. Note that both 32 and 64 bits operating 

system tools are provided, select the appropriate version compatible with your operating system. 

Compatibility issues: 

It was noted that: 

 The EO4SD toolbox requires at least ‘Windows‐7’, preferably Windows‐10 

 If Python version 2.7 is installed on your system the toolbox will not work, delete the older 

Python2.7 version from your system. 

 

 

 
 


